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Overview
The Impress Custom Engraving Software provides custom engravings for the latest Crestron®
engravable products, including remotes, keypads, signs, and more. The software is backwards
compatible with Crestron Studio® software and engravings created with the Crestron Home® OS.
Design options include engraving icons, mixing fonts on a single line, and styling text with emphasis,
alignment, and font size. The software uses engraving technology to ensure what is designed on-screen
matches the final product the customer receives.

NOTE: Available engraving options may vary depending on the Crestron product.

https://www.crestron.com/model/3002192
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Supported Devices
The Impress software can be used to engrave most keypads, remotes, and signs. Supported device
families include:

C2N-CBD HZ-AUX
C2N-CBF HZ-DIMEX
C2NI-CB HZ-DIMLVEX
CLW-DELVEX-277 HZ-DIMUEX
CLW-DELVEX HZ-KPCN
CLW-DIMEX-277 HZ-KPEX
CLW-DIMEX HZ-SWEX
CLW-DIMFLVEX HZ2-AUX
CLW-DIMSWEX HZ2-DIMEX
CLW-DIMUEX HZ2-DIMLVEX
CLW-SLVU HZ2-DIMUEX
CLW-SWEX HZ2-KPCN
CLWI-DIMFLVEX HZ2-KPEX
CLWI-DIMUEX HZ2-SWEX
CLWI-DIMUNEX INET-CBDEX
CLWI-KPLCN MPC3-102
CLWI-KPLEX SSC
CLWI-KPLEX-BATT SSW
CLWI-SWEX ZUMLINK-KP
HR-150 ZUMMESH-KP10AV4BATT
HR-310 ZUMMESH-KP10AV5BATT
HTT-B10EX ZUMMESH-KP10FBATT
HTT-B2EX-BATT ZUMMESH-KP10GBATT

System Requirements
Minimum Computer Requirements

Operating System Windows 10® and 11;
Compatible with 64-bit (recommended) or 32-bit platforms

CPU 2 GHz or faster (multi-core recommended)

Memory 4GB RAMminimum (8 GB RAM recommended)

Storage 1GB

NOTE: Additional space is required to store engraving projects.

Display 1920x1080 resolution or higher recommended
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Installation
Use the following procedure to install Impress software.

NOTE: If Microsoft® .NET Core software is not already installed on the computer, you will be
prompted to install it before continuing with the Impress installation.

1. Download the latest Impress installer package from the Software & Firmware resource page at
www.crestron.com/Support/Resource-Library or the Impress software product page.

2. Launch the Impress installer.

If Microsoft .NET Core is not installed on the computer, the Setupwindow displays prompting the
Microsoft .NET Core installation.

a. Select Yes to install Microsoft .NET Core. The download website opens in the default web
browser.

NOTE: Impress will not run without Microsoft .NET Core installed.

b. If Microsoft .NET Core does not download automatically, select the link to download it and
run the installer.

c. Once Microsoft .NET Core is downloaded, open the program.

https://www.crestron.com/Support/Resource-Library
https://www.crestron.com/model/3002192
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d. Select Install to run the installer.

e. When the Installation is finished, close the window.

f. Relaunch Impress.

3. Select Next to start the Impress SetupWizard.
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4. Accept the License Agreement, and select Next. Select Back to view the previous window.

5. Select Next to keep the recommended program location, or click Browse to install Impress in a
different location.
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6. (Optional) Select the box to add a shortcut to your Desktop, then select Next to continue.

7. Select Next to keep the recommended Start Folder location, or select Browse to select a different
location.
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8. Review the Security Software Degrades Performancewarning, and select Next to continue.
l Select Copy To Clipboard to copy the files listed.
l Select the check box to stop displaying the message.
l Select Back to view the previous window.
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9. Fill in your contact information and select Finish. This information will be used to send orders and
support information to Crestron Electronics, Inc..

NOTE: Some fields may change depending on the Country selected.
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10. Select Finish and relaunch Impress. By default, the Impress Start Page displays.

Start Page
The following sections describe the Start Page and correspond to the numbers on the following image.
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1. Menu Bar on page 16

2. Open Engravings Project on page 16

3. New Engravings Project on page 16

4. Search Projects on page 16

5. Recent Projects List on page 16

6. Options on page 17

7. Device Updates Available on page 17

Menu Bar
Some menu items are accessible from the Start Page. For description of all of the menu items, refer to
Save Icon and Menu Bar on page 18.

Open Engravings Project
Use the Open Engravings Project section to open an existing project. Refer to Open an Existing Project
on page 44 for details.

New Engravings Project
Use the New Engravings Project section to start a new project. Refer to Start a New Project on page 43
for details.

Search Projects
To find a previous project, use Search Project to filter projects displayed in the Recent Projects list. Start
typing the project name in the Search Projects text field, and the Recent Projects list will narrow to
show projects related to the search term.

Recent Projects List
Recent projects are populated in the Recent Projects list. Right click on a project to access the Recent
Projects list menu.
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Menu actions include:

l Remove From List: Select to remove a project from the Recent Projects list.
l Pin to Recent Project List: Select to pin a project to the Recent Projects list. Pinning a project
keeps the project at the top of the Recent Projects list. The first pinned project creates a Pinned
category.

l Copy Path: Select to copy a project file path to the clipboard.

Recent Projects List Menu

Options
By default, both Start PageOptions are selected. Clear an undesired option to change the Start Page
behavior.

Options include:

l Close this page after a project loads
l Show this page on startup

Device Updates Available
To check for updates, refer to Device Updates Available on page 40.
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Engravings Designer
The following sections describe the Impress software workspace and correspond to the numbers on the
following image.

1. Save Icon and Menu Bar on page 18

2. Engravings Designer Tab on page 28

3. Toolbars on page 28

4. Tool Windows on page 30

5. Canvas on page 39

6. Zoom on page 40

7. Device Updates Available on page 40

Save Icon and Menu Bar
Use these options to manage the Impress software.

Save Icon
After making a change to a project, an asterisk (*) displays in the Engravings Designer tab. Select the
Save button to quickly save the open project. For more saving options, refer to Save a Project on page
61.

Save Icon
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File Menu
The Filemenu contains options to start a New Project, Open Project, Save a project, Save As another
project name, Save All projects, Rename a project, Close an open project, Import a project, and Export a
project.

File Menu

For more information about the following topics:

l For more information about New Project, refer to Start a New Project on page 43.
l For more information about Open Project, refer to Open Engravings Project on page 16.
l For more information about Rename a Project, refer to Rename a Project on page 63.
l For more information about Save a project, Save As another project name, Save All projects,
refer to Save a Project on page 61.

l For more information about Import and Export, refer to Import or Export Engravings on page 65.

Edit Menu
The Editmenu contains options to Cut, Copy, Paste, and Delete selected Engravings from the
Engravings Tool Window or selected engraving text. Customize software settings by selecting
Engravings Designer Options. The options relate to various warning and confirmations that display
after certain actions. By default, all options are selected.
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Engravings Designer Options

Engravings Designer Options:

l Ask before deleting Engravings permanently:When an engraving is deleted, this confirmation is
displayed.



Product Manual — Doc. 9377B Impress Software • 21

l Show Image Disclaimer warning:When an order that contains an image is created, this warning is
displayed.

l Show Print Cutoff warning: When engravings are set to be printed on paper that is too small, this
warning is displayed.
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l Show export order information warning:When a project is exported, this warning is displayed.

Actions include:

l Clear any undesired options.
l Select Apply to implement changes immediately without closing the window.
l Select OK to apply changes after the windows closes.
l Select Cancel to close the window without making any changes.

Edit Menu

View Menu
The Viewmenu provides options for customizing the workspace.

View Menu
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Toolbars
Toolbars are easily accessible icons in the workspace used to edit and complete an engraving.

l The Toolbarsmenu allows you to remove any undesired Toolbars from the Toolbar workspace.
l Toolbars include Engravings, Engraving List, and Font.
l By default, all Toolbars are selected and present in the Toolbars workspace. Clear a Toolbar to
remove it from the Toolbars workspace.

Refer to Toolbars on page 28 for more information.

Toolbars Menu

Toolbars Workspace

Tool Windows Menu
Tool Windows provide designated areas for engravings and designer tools. The four tools include
Engravings, Parts/Layouts Gallery, Configuration Gallery, and Font Selector. Tool Windows are
moveable and can be rearranged in the workspace. The Tool Windowsmenu provides options for
displaying the Tool Windows.

l Select Toggle visible tool windows to remove the windows from the workspace.
l Contain Floating Tool Windows is selected by default. When selected, undocked Tool Windows
can be moved from the default position within the workspace. When cleared, the Tool Windows
can be moved outside of Impress.

l By default, all Tool Windows are selected and present in the workspace. Clear a Tool Window to
remove it from the workspace.

Refer to Tool Windows on page 30 for more information.
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Tool Windows Menu

Tool Windows

Project Menu
The Projectmenu provides options for the open project: create a New Engraving, Order Engravings,
Print Engravings, Export Engravings, Import Engravings from another project to the open project,
Import Crestron Home Engravings to the open project, and Export Selected Engravings.

Project Menu
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For more information about the following topics:

l For more information about New Engraving, refer to Add a New Engraving on page 45.
l For more information about Order Engravings, refer to Create an Order on page 78.
l For more information about Print Engravings, refer to Print Engravings on page 76.
l For more information about Export Engravings, Import Engravings, Import Crestron Home
Engravings, and Export Selected Engravings, refer to Import or Export Engravings on page 65.

Tools Menu
The Toolsmenu provides access to the Start Page, Device Maintenance, and Impress Options.

Tools Menu

l Select Start Page to launch the Start Page tab.
l Select Device Maintenance to open the update software. Refer to Device Updates Available on
page 40 for more information.
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l Select Impress Options to access the General and Output/Logging tabs.
o General: Use the General tab to enter Contact Information.

NOTES:
n Any information provided during the Impress installation will be automatically

entered here.
n Some fields may change depending on the Country selected.

o Output/Logging: Use Output/Logging to configure messages and logging settings for
advanced debugging. It is not recommended to make changes to the Output/Logging pages
unless instructed by a Crestron representative.
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Window Menu
TheWindowmenu provides options for managing open project and tabs.

l When multiple Engravings Designer tabs are open:
o Select Switch Designers to view another tab.
o Select Previous Designer to open the preceding tab.
o Select Next Designer to open the next tab.
o Select Close All But Current Designer to close all tabs but the open tab.
o Select Close All to close all tabs.

l Select Close to close the open tab.
l Select Close the Tool Window to close the selected Tool Window.
l Select Float to undock the selected Tool Window from its position in the workspace.
l Select Dock to lock the selected floating Tool Window to a position option.
l Select Auto Hide to automatically collapse the selected Tool Window to the left when not in use.
l Open tabs are listed at the bottom of the menu. Select the desired tab to open it.

WindowMenu

Help Menu
The Helpmenu provides support for using Impress and information about the software.

l Select Impress Help to access the help file.
l By default, Use Offline Help Only is selected. Clear it for the online version.
l Select Release Notes to access updates or changes to the software.
l Select About Impress to access version information.
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Help Menu

Engravings Designer Tab
The Engravings Designer tab includes the workspace for the project. If a change is made to a project but
the project has not been saved, an asterisk (*) appears. Multiple project (Engravings Designer) tabs can
be open at one time. Close the tab to exit the project.

Toolbars
Use the Toolbars to create and style engravings. Toolbars include Engravings List, Engraving, and Font.

Toolbars Workspace

Engravings List
Select New to create a new engraving. Use the drop-down menu to select a saved engraving.

Engravings List Toolbar
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Engravings
Use the Engravings Toolbar to start the order process, show or hide editable text fields on the device,
export or print engravings, or select a color variant (when applicable).

l Select Create Order to start the order process.
l Select Show/Hide Areas to show or hide the editable text fields of the previewed device in the
canvas.

l Select Export Engravings to export an engravings file (.ct_engravings).
l Select Import Engravings to navigate to and import an engravings file.
l Select Print Engravings to print an engravings file (.ct_engravings).
l SelectModels drop-down menu to select a color variant of the device, if applicable.

Engravings Toolbar

Sample Editable Text Fields

Font
Use the Font Toolbar to style the engraving text.

NOTES:

l Available options may vary depending on the Crestron product.
l The font size drop-down menu cannot be used to change the font size for the SSC and SSW
series room availability signs. To change the font size, select the layout in the Parts/Layouts
Gallerywith the corresponding font size.
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Font Toolbar

l Select a font from the Font Family drop-down menu. Fonts include:

l Select a typeface style from the Font Family Typeface drop-down menu. Typeface styles include:

l Select a font size from the Font Size drop-down menu.
l Use Increase or Decrease to increase or decrease the font size.
l Use font styles to bold, italicize, or underline text.
l Select a Line height option from the Line Height drop-down menu.
l Use text alignment to left, center, or right justify text.

Tool Windows
Tool Windows provide designated areas for engravings and designer tools. The four tools include
Engravings, Parts/Layouts Gallery, Configuration Gallery, and Font Selector. By default, the four tools
are divided into two windows with Engravings in one Tool Window and Parts/Layouts Gallery,
Configuration Gallery, and Font Selector all combined into a second window. All tools can be combined,
split, or moved around the workspace.
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All Tool Windows have four common behaviors: Float, Dock, Auto, Hide, and Close.

l Select Options to view window behaviors.
o Float: Select to undock the window from its position in the workspace.
o Dock:When undocked, click to snap the window back into position.
o Auto Hide: Select to automatically collapse the window to the left when not in use.
o Close: Select to close the window.

l Select Auto Hide to automatically collapse the window to the left when not in use.
l Select Close to close the window.

To rearrange the workspace:

1. Select Float to undock a Tool Window.
The tool window is no longer locked into position and can be moved.

2. To dock the Tool Window in a new location, select and drag the window.
Docking location options appear on the screen.

3. Drag the window to the desired location.

NOTE: If Contain Floating Tool Windows is selected in the Tool WindowMenu, the Tool Window
stays within the workspace. If Contain Floating Tool Windows is not selected, the Tool Window can
be moved outside of Impress. Refer to Tool Windows Menu on page 23.
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Docking Location Options

Engravings Tool Window
Use the Engravings Tool Window to create and manage engravings.

Engravings Tool Window
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l Select New to create a new engraving.
l Engravings lists created engravings.

o Name: Name of the engraving.
o Model: Device being engraved.
o Part Type: Engraving Only or Device + Engraving (SSW and SSC only).

NOTE: For Horizon® 2 keypads:
n You can choose to order the Device + Engraving or Engraving Only if you already

have the device.
n Additional charges may apply for Engraving Only. Consult with Customer

Support for concerns.

l Select Delete to delete a selected engraving. A confirmation opens. Select Yes to delete the
engraving or No to close without deleting.

l Right click on an engraving to view the following menu options.
o New: Create a new engraving.
o Delete: Delete the selected engraving
o Rename: Rename the selected engraving.
o Copy: Copy the selected engraving.
o Paste: Paste a copied engraving to the Engravings list.
o Export Engravings: Export all engravings to the project folder.
o Export Selected Engravings: Export a selected engraving(s) to the project folder.

Engravings Menu

https://www.crestron.com/Support
https://www.crestron.com/Support
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Parts/Layouts Gallery
Parts/Layouts Gallery shows the available layout options for the model. Options vary depending on the
device. For keypads, Part/Layouts Gallery includes different button sizes and engraving locations. Parts
and layouts are stored in folders. Use Collapse All and Expand All to open or close all folders.

For SSC and SSW signs, the parts listed refer to the font size allowed in the engravable space. Select
the layout based on the font size required to adequately display the text.

Collapse an Expand All Folders

Parts/Layouts Gallery for HZ-KPEX
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Parts/Layouts Gallery for SSW

Configuration Gallery
Configuration Gallery shows a default configuration for a device. Save any custom configurations for
easy implementation across engraving projects.

Key Configuration Gallery
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Save or Delete Configuration
To save a custom configuration:

1. Create an engraving with the desired text and/or button arrangement in the canvas.

2. Select Save Current Configuration in the Configuration Gallery.

The new configuration, named Custom, appears under the default configuration .

Save Current Configuration

Rename Configuration
To rename a custom configuration:

1. Select the configuration.

2. Select on or after the name Custom, and type the desired name.

Renamed Custom Configuration Sample
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Apply a Configuration
To apply a configuration to an engraving, select the configuration and drag it to the canvas.

Delete Configuration
To delete a custom configuration:

1. Select the custom configuration.

2. Select Delete Configuration.

Delete Current Configuration



38 • Impress Software Product Manual — Doc. 9377B

Font Selector
Font Selector displays available fonts for each specific device and a characters table for the selected
font. Font options vary depending on the device.

Font Selector
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Canvas
The canvas shows the device selected when a new engraving is created. Use the device on the canvas to
arrange layouts and enter text or images for the engraving.

Canvas

Sample Editable Text Fields
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Zoom
By default, Zoom is set to 100%. The device on the canvas can be viewed from 25% to 6400%.
Engravings viewed at 100% zoommay not accurately represent the physical engraving. Zoom to 200%
for an accurate representation of the engraving. To zoom, either select and scroll the mouse wheel or
select 100.00% to open the Zoom options.

The following Zoom options are provided:

l Zoom in and out using the Zoom In and Zoom Outmagnifying glasses, dragging the lever up and
down, or choosing an increment from the menu.

l Use the Reset Zoommagnifying glass to set the zoom back to 100.00%.
l Use Zoom to Fitmagnifying glass to zoom in to fit the device to the canvas.

Device Updates Available
To check for updates:

1. Select on Device Updates Available to access the Device Maintenance page.

2. If updates are not listed, select Install to populate available updates.

3. Select the desired update(s).

4. Select Install to download and install the update, or click Remove to remove the update from the
list.

NOTE: The software is up to date when the Install? check box is clear and Install Status says
Installed.
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Keyboard Shortcuts
The following keyboard shortcuts are available:

Shortcut Keys Functionality Location

View context-sensitive help. N/A

+ Save engravings project.

+

+

Save all projects.

+ Launch Create Order window

+ Launch Print window

+ Add new engraving. Engravings Tool Window on page 32

Rename engraving.
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Shortcut Keys Functionality Location

+ Bold engraving text Editable fields of device in the Canvas on page 39

+ Italicize engraving text

+ Underline engraving text

+ Left align engraving text

+ Center engraving text

+ Right align engraving text

+ Import image

+

+

Exclude part from order
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Start a New Project
To begin a new project:

1. On the Start Page, select Create New Project in the New Engravings Project section. The New
Projectwindow displays.

NOTE: The New Projectwindow is also accessible from the Menu Bar (File > New Project) or
by using the keyboard shortcut Ctrl+Shift+N.

2. Enter the Project Name.

NOTE: Follow these requirements for naming a project:
l Do not use the characters <>~|/\?* :"
l Do not start or end the name with a space.
l Do not end the name with a period.
l The full project path cannot exceed 248 characters.

3. Verify the file location. If the file location needs to be changed, select Browse to navigate to the
Engravings folder.

Engraving projects may be stored in any folder. By default, Impress stores projects at the
following location: C:\Users\User_Name\Documents\Crestron\Projects.

New Project
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Open an Existing Project
To open engraving files created with Impress or the Crestron Studio software:

1. On the Start Page, select Open Existing Project in the Open Engravings Project section. The Open
Projectwindow displays.

NOTE: The Open Projectwindow is also accessible from the Menu Bar (File > Open Project) or
by using the keyboard shortcut Ctrl+Shift+O.

2. Navigate to the Engravings project.

Engraving projects may be stored in any folder. By default, Impress stores projects at the
following location: C:\Users\User_Name\Documents\Crestron\Projects.

Impress remembers the last used path.

3. In the Engravings folder, open the desired project folder and select the .ct_engravings file.

4. Select Open to open the engravings project and the project displays in a new tab, or click Cancel
to close without opening.

Once the project is open, the engraving text and layout can be edited and ordered. Refer to Create an
Engraving on page 45 for more information.
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Create an Engraving
When an engraving is created, the Parts/Layouts Gallery, Configuration Gallery, and Font Selector Tool
Windows populate with options specific to the device. Options vary depending on the device.

Add a New Engraving
To add an engraving to a project:

1. Select New in the Engravings Tool Window or use the keyboard shortcut Ctrl + N.

The New Engravingwindow displays.

2. (Optional) Choose Show Discontinued and Obsolete Devices to display devices in the Device
drop-down menu that are discontinued or obsolete.

By default, Show Discontinued and Obsolete Devices is unchecked.

3. Enter the following fields:
l Name: Type the name of the engraving.
l Device: Select a product family from the drop-down menu.
l Model: Select the specific model from the drop-down menu.
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New Engraving Sample

Parts/Layouts Gallery
For devices with multiple parts or layout options, drag and drop a part or option from the
Parts/Layouts Gallery to the previewed device in the canvas. When hovering the part over the device, a
yellow outline highlights the position on the device. When applicable, mix and match parts to design the
desired layout. Refer to Parts/Layouts Gallery on page 34 for more information.

Configuration Gallery
View the default configuration for the device or save a new configuration to apply to device engravings.
Refer to Configuration Gallery on page 35 for more information.
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Font Selector
To style engraving text:

1. Select in an editable text field on the device to view the font options available. Fonts populate in
the Selected Font drop-down menu.

NOTE: The font size drop-down menu cannot be used to change the font size for the SSC and
SSW series room availability signs. To change the font size, select the layout in the
Parts/Layouts Gallerywith the corresponding font size.

2. Select a font and type the desired text.

TIP: For SSC and SSW signs, consider changing the Font Family Typeface to Condensed if the
text does not fit in the engravable area.

3. Use the Font Toolbar to align or add emphasis to text.

NOTES:

l Options vary depending on the device.
l More than one font may be used in an editable text field.
l The font size may adjust automatically to fit in the text field.
l If the editable text field allows, text may wrap to two lines.
l Text may be copied and pasted to other fields
l Refer to Font on page 29 and Font Selector on page 38 for more information
l When the engravable area character limit is met, Impress displays the following notification
and additional characters cannot be entered.

Add an Image
Certain devices allow image engraving.

NOTES:

l Supported file types include .jpg, .png, and .bmp.
l Supported devices include the HR-310, MPC3 family, SSC, and SSW.



48 • Impress Software Product Manual — Doc. 9377B

To add an image:

1. Right click in an engravable area. The menu option to Import Image option appears and details the
maximum file size in pixels allowed in the area.

Alternatively, use the keyboard shortcut Ctrl + D to open the Select Resources to Importwindow.

2. Select Import Image. The Select Resources to Importwindow displays.

3. Navigate to the image file and select Open.

Refer to Engraving Images on page 49 for details.

Add an Image

Engravings Tool Window
To manage engravings in the Engravings Tool Window, right click to access the menu options.

l New: Create a new engraving. Refer to Add a New Engraving on page 45.

Keyboard shortcut Ctrl + N.
l Delete: Delete the selected engraving.

Keyboard shortcut Delete.
l Rename: Rename the selected engraving.

Keyboard shortcut F2.
l Copy: Copy the selected engraving.

Keyboard shortcut Ctrl + C.
l Paste: Paste a copied engraving to the Engravings list.

Keyboard shortcut Ctrl + P.
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l Export Engravings: Export all engravings to the project folder.

Refer to Export Engravings File on page 70.
l Export Selected Engravings: Export selected engravings.

Refer to Export Engravings File on page 70.

Engravings Menu

Engraving Images
The following sections describe best practices for engraving images.

Compatible Products
At this time, images can be imported and engraved on the following devices:

l HR-310
l MPC3 series
l SSC and SSW series

Black and White Images
Images must be one-bit monochrome (each pixel is either black or white). Impress software can convert
color images to one-bit monochrome; however, it is not a graphics editing software and may not
produce the desired quality. If the image required is only in color, use a third-party application to convert
the image to black and white before importing it.

If converting the color image to black and white in a third-party application is not an option, ensure the
color image does not use gray-scale or too many colors. These scenarios may result in a converted image
that is flat and lacks detail. Inspect the image after importing. If you are not satisfied with the
converted black and white image, remove it and use a third-party application to make necessary
adjustments.
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Color Image Conversion

When imported, the original color image (left) will convert to a monochrome black and white image
(right).

Recommended Image Size
Follow the size recommendation for the engravable field. Because not every field has the same size
requirements, check the recommended size before importing an image. Determine the recommended
size by right clicking in the engravable area. Refer to Add an Image on page 47.

Images smaller than the recommended size render at their actual size, centered in the engravable area.
Larger images scale down to fit the engravable area. To avoid decreased performance, do not import
images that are several times larger than the recommended size. If needed, use a third-party
application to resize the image before importing.

NOTE: High-resolution images may effect Impress performance.
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Import Image Dimensions

HR-310 with Smaller Image

When imported, the original image (left) renders at its actual size in the engravable area size
865 x 120 px (right).

HR-310 with Larger Image

When imported, the original image size 1023 x 500 px (left) will scale to the engravable area size
328 x 186 px (right).
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Circular Images
If an image contains circles, half-circles, or curves, ensure the outline is least three pixels wide.

Zoom
To make sure engraved images display as desired, zoom in to at least 200-300% in the Workspace.
Refer to Zoom on page 40 for details.
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Engravable Devices
The following section describes some of the common device families supported by Impress software.

Horizon® 2 Keypads

The following models are supported by Impress software.

l HZ2-KPCN
l HZ2-KPEX
l HZ2-DIMEX
l HZ2-DIMUEX
l HZ2-DIMLVEX
l HZ2-SWEX
l HZ2-AUX

The Horizon 2 keypads use button-tree configurations. Each configuration has buttons with one or more
engravable areas, and the total number of engravable areas varies depending on the configuration. One
line of text can be engraved in each engravable area.

The following Horizon 2 button-tree configurations are possible:

l Five single pushbuttons
l Four single pushbuttons and one side-to-side rocker in the fifth position
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l Four single pushbuttons and one side-to-side rocker in the fourth position
l Three single pushbuttons and two side-to-side rockers in the fourth and fifth positions
l One medium rocker (consisting of three pushbuttons covering the first, second, and third
positions) and two single pushbuttons in the fourth and fifth positions

l One large rocker, consisting of three pushbuttons in the first, third, and fifth positions

NOTES:

l HZ2-AUX has only one button-tree option: One large rocker consisting of three pushbuttons in
the first, third, and fifth positions.

l The Horizon 2 keypads do not support engraving in lower case letters or image engraving at
this time.

l More that one font size and more than one font may be used in an engravable area.
l The engravable areas for side-to-side rocker buttons adjusts depending on the length of the
text.
Default Engravable Area

Adjusted Engravable Areas

Refer to the following topics for more information:

l Create an Engraving on page 45
l Create an Order on page 78
l Exclude a Part from an Order on page 81
l Impress Best Practices on page 94
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Horizon Keypads

The following models are supported by Impress software.

l HZ-KPCN
l HZ-KPEX
l HZ-DIMEX
l HZ-DIMUEX
l HZ-DIMLVEX
l HZ-SWEX
l HZ-AUX

The Horizon keypad buttons have one or more engravable areas, and the total number of engravable
areas varies depending on the keypad button configuration. One line of text can be engraved in each
engravable area.

The Horizon keypads provide four button styles:

l One pushbutton
l One side-to-side rocker
l One medium rocker, consisting of three pushbuttons covering the first, second, and third positions
l One large rocker, consisting of three pushbuttons in the first, third, and fifth positions
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NOTE: The Horizon keypads do not support engraving in lower case letters or image engraving at
this time.

Refer to the following topics for more information:

l Create an Engraving on page 45
l Create an Order on page 78
l Exclude a Part from an Order on page 81
l Impress Best Practices on page 94
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HR-310 Remote

The HR-310 remote has custom buttons and a top label that are engravable. The HR-310 has an
engravable part (HR-310-BTN_ENGRAVED) which can be ordered and consists of the custom button
and top label engravable areas. One line of text can be engraved in each engravable area.

https://www.crestron.com/model/6508587
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NOTE: The HR-310 remote does not support engraving in lower case letters or image engraving at
this time.

Refer to the following topics for more information:

l Create an Engraving on page 45
l Engraving Images on page 49
l Create an Order on page 78
l Exclude a Part from an Order on page 81
l Impress Best Practices on page 94

MPC3-201/MPC3-201 Presentation Controller

The MPC3-201 has two engravable areas. A part (MPC3-BTN3-B) can be ordered for each engravable
area. Each engravable area (six total) supports an image or up to two lines of text.

Refer to the following topics for more information:

l Create an Engraving on page 45
l Engraving Images on page 49
l Create an Order on page 78
l Exclude a Part from an Order on page 81
l Impress Best Practices on page 94

https://www.crestron.com/model/6509662
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MPC3-302/MPC3-302 Presentation Controller

The MPC3-302 has one engravable area. A part (MPB3-MPC3-BTN10-B ENGRAVED) can be ordered
that consists of 10 engravable buttons. One line of text can be engraved in each engravable area.

Refer to the following topics for more information:

l Create an Engraving on page 45
l Engraving Images on page 49
l Create an Order on page 78
l Exclude a Part from an Order on page 81
l Impress Best Practices on page 94

Room Availability Signs (SSC and SSW)
The sign face is custom engravable with the room number, name, or other designation. The complete
sign assembly mounts to the wall or the ceiling over a single-gang electrical box or plaster ring.

The engraving appears on both sides of the acrylic sign face to identify the room by name or number.
When illuminated, the engraving is clearly visible at a distance of 50 ft (15 m). Engraving can be changed
at any time by purchasing a replacement sign face.

The status sign has one engravable area. Parts (SSC-ACR-102/SSC-ACR-102-EL or
SSW-ACR-102/SSW-ACR-102) can be ordered and consist of one engravable area. Impress provides
four layouts that allow up to two lines of text to be engraved in the engravable area.

NOTE: The font size cannot be changed through the Font Size drop-down list. The only way to
change the size of the font is by selecting a different layout.

https://www.crestron.com/model/6510220
https://www.crestron.com/model/6508242
https://www.crestron.com/model/6510597
https://www.crestron.com/model/6508243
https://www.crestron.com/model/6510596
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SSW

SSC
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Save a Project
The following sections describe the various options for saving a project.

NOTE: After making a change in a project, an asterisk (*) displays in the Engravings Designer tab,
indicating that the project is unsaved.

Save from the File Menu
The Filemenu contains options to Save, Save As, and Save All.

File Menu

Save
Select Save or use the keyboard shortcut Ctrl+S to save the open project.

Save As
Select Save As to save the open project with a new name or in a new location.
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Save All
Select Save All or use the keyboard shortcut Ctrl+Shift + S to save all open projects.

Save Icon
Select the Save button to quickly save the open project.

Save Icon
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Rename a Project
To rename a project:

1. Open the project.

2. From the Menu Bar, select File > Rename.

3. When the Rename Projectwindow displays, enter the desired name in the New Name field.

4. Select Rename to rename the project or Cancel to close the window without renaming the project.

NOTE:When a project is renamed, the project saves and closes.
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Delete a Project
Use the File Explorer to delete a project folder.

1. In the File Explorer, navigate to the project folder.

2. Right click on the desired folder.

3. Select Delete.
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Import or Export Engravings
Engraving files can be shared among Impress software users by exporting engravings and sharing the
export files. Crestron Studio engravings can also be imported into and used in Impress software.
Engravings can be imported as separate projects or merged into an existing project.

Import an Engravings File as a Separate
Project
To Import an engravings file:

1. Navigate to File > Import > Import Project....

2. Navigate to the desired file.

3. Select the file and select Open to open the Import Towindow, or select Cancel to close without
opening a file.

4. Confirm the file being imported and the Locationwhere the file will be stored. If a new location is
necessary, select Browse to store the file in a different location.
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5. Select Import to import the files and open the File Import Assistant/Configure Importwindow, or
click Cancel to close without importing.

6. Review the information in the File Import Assistant/Configure Importwindow.
l To change the name of the project, double click in the Project Name field and overwrite the
name.

l To change the storage location of the project, select Browse to navigate to a different file
location.

l Select Next to open the File Import Assistant/Import Resultswindow, or select Cancel to
close without importing.
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7. Review the File Import Assistant/Import Resultswindow.
l To open the project once the import is complete, check the Open? box.
l To copy the project information, including the project file path, select Copy To Clipboard.
l To complete the import, select Finish.
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Import a Crestron Home OS Engravings
File as a Separate Project
To import a Crestron Home OS engravings file:

1. Navigate to File > Import > Import Crestron Home Engravings. The Import Crestron Home
Engravings - New Project dialog box is displayed.

2. Fill out the Import Crestron Home Engravings - New Project dialog box.
l Enter the new Project Name.
l Keep the location as is, or select Browse to set a new storage location for the project.
l Select New to navigate to the file.
l Select Cancel to close without opening a file.

3. Navigate to the desired file and select the file.

4. Select Open to open the Import Towindow, or select Cancel to close without opening a file.
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Merge Projects
To import engravings from one project into another:

1. Open the project that will receive the imported files.

2. Navigate to Project > Import Engravings.

NOTE: Import Engravings is also accessible from Import in the Engravings toolbar.

3. Navigate to the desired file, select the file, and select Open to immediately import engravings.
Select Cancel to close without importing engravings.

4. Confirm the engravings have been added to the Engravings Tool Window.
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Merge a Crestron Home OS Engravings
File
To merge a Crestron Home OS engravings file into another project:

1. Create a new project or open an existing project to import the Crestron Home OS engravings to.

2. Navigate to Project > Import Crestron Home Engravings..

NOTE: Import Crestron Home Engravings is also accessible from Import in the Engravings
toolbar.

3. Browse to and select the file Crestron Home OS engravings zip file.

4. Select Open and the file imports into the project.

Export Engravings File
Export engravings to easily share files with other Impress users. There are two options for exporting
engravings: Export Engravings and Export Selected Engravings.

CAUTION: Do not use an exported engravings file to submit an order. For more information, refer to
Create an Order on page 78.
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Export Engravings
To export all engravings in the project:

1. Select the Export Engravingsmenu.
Engravings Toolbar

NOTE: The Export Engravings is also accessible from the Menu Bar (File > Export or
Project > Engravings > Export Engravings).

2. Select Export Engravings to open the Enter an export file name window.
Export Engravings Menu
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3. Review the Enter an export file name window.
l If necessary, change the file name. By default, the project name is entered in the File name
field.

l If another location is necessary, navigate to a different location. By default, the location is
set to the Engraving's project folder.

l The file type exports as .ct_engraving_x.

4. Select Save to export the file or Cancel to close without exporting. When the export file is saved,
the following warning displays. Select OK to close the warning.
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Export Selected Engravings
To export specific engravings in the project:

1. Select the desired engravings from the Engravings Tool Window.

2. Select the Export Selected Engravingsmenu.
Engravings Toolbar

NOTE: The Export Selected Engravings is also accessible from the Menu Bar
(Project > Engravings > Export Selected Engravings).

3. Select Export Selected Engravings to open the Enter an export file name window.
Export Engravings Menu
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4. Review the Enter an export file namewindow.
l If necessary, change the file name. By default, the project name is entered in the File name
field.

l If another location is necessary, navigate to a different location. By default, the location is
set to the Engraving's project folder.

l The file type exports as .ct_engraving_x.

5. Select Save to export the file or Cancel to close without exporting. When the export file is saved,
the following warning displays. Select OK to close the warning.
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Preview and Print Engravings
To preview and print an engraving, select Print Engravings in the Engravings Toolbar. The Print
Engravingswindow displays.

Engravings Toolbar

NOTES:

l The Print window is also accessible from the Menu Bar
(Project > Engravings > Print Engravings) and the keyboard shortcut Ctrl+P.

l The following warning displays if the paper size is smaller than the engraving being printed.
Select OK to close the window and follow the recommended solution.
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Print Engravings
Use the Print Engravingswindow to preview and print an engraving.

l Engravings list: Select an engraving to see the engraving information and display the engraving in
the preview. Check the box next to an engraving to print it.

 The Engravings list details the following information:
o Name: The assigned name of the engraving.
o Type: The device type for the engraving.
o Qty: The number of engraved devices being ordered for the engravings.

NOTE: To change the quantity, refer to Create an Order on page 78.

o Availability: The status of the product's availability. If the engraving can be ordered, the
Availability states Available. If the engraving can't be ordered, the Availability states
Discontinued, Obsolete, or Limited Supply.

l Fit to Viewing Area: By default Fit to Viewing Area is selected. Clear it to preview the full image
which may extend out of the viewing area.

NOTE: The image is a preview only and does not represent the physical engraving.

l Engraving preview: The device and engraving preview.
l Actions:

o Page Setup: Set page properties for printing engravings.
o Print Preview: Preview the engravings for printing. Print Preview includes the Engraving
preview, device information, and shipping information.

o Print: Launch the Print window to select a printer, set printer properties, and print.
o Close: Exit the Print Engravingswindow.
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Create an Order
Follow these simple steps to create an order. For detailed steps, refer to Create Order Details on page
82.

NOTES:

l The Create Engravings Orderwindow is also accessible from the Menu Bar
(Project > Engravings > Order Engravings) and the keyboard shortcut Ctrl+O.

l To exclude a part from an order, refer to Exclude a Part from an Order on page 81.

1. Click Create Order in the Engravings toolbar to open the Create Engravings Orderwindow.

2. In the Engravings tab, select the engraving(s) and enter the quantity for each. For more
information, refer to Engravings on page 84.

a. Select the desired engraving(s).

b. Enter the necessary quantity.
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3. In the Shipping tab, enter information into ALL of the required fields marked with an asterisk (*).
For more information, refer to Shipping on page 87.

Required fields: 

a. Billable Dealer Information:

i. First Name

ii. Last Name

iii. Address 1

iv. Country City

v. State

vi. Zip/Postal Code

b. Shipping Address

Select Use Dealer Billing Address or enter the required information:

i. First Name

ii. Last Name

iii. Address 1

iv. Country City

v. State

vi. Zip/Postal Code
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4. (Optional): In the Shipping Label tab, enter information for Room and Description. For more
information, refer to Shipping Label on page 89.

5. In the Order Summary tab, enter information into ALL required fields marked with an asterisk (*).
For more information, refer to Order Summary on page 89.
Required fields:

a. Dealer PO Number

b. Project Name

c. Select Your Primary Crestron Sales Office

6. Complete the order:

a. Create Order Create and save an engravings order. For more information, refer to Create
Order on page 90.

b. Create and Email Order: Create and save an engravings order, and launch the default email
application with the order attached. For more information, refer to Create and Email Order
on page 92.

If you experience issues while creating an order, refer to Troubleshooting on page 98.
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Exclude a Part from an Order
To exclude a part from an order:

1. Select the engraving from the Engravings Designer tab. A preview of the device displays in the
Canvas.

2. In the Canvas, right click on the part and select Exclude Part from Order. An X displays over the
part.

Exclude Part from Order Option

Excluded Parts
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Create Order Details
To order an engraving, select Create Order in the Engravings toolbar. The Create Engravings Order
window displays.

Engravings Toolbar

NOTE: The Create Engravings Orderwindow is also accessible from the Menu Bar
(Project > Engravings > Order Engravings) and the keyboard shortcut Ctrl+O.

The Create Engravings Orderwindow has four tabs of information:

l Engravings on page 84
l Shipping on page 87
l Shipping Label on page 89
l Order Summary on page 89

NOTE: To exclude a part from an order, refer to Exclude a Part from an Order on page 81.
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Engravings
The Engravings tab offers similar information as the window shown in Print Engravings on page 76.
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l Selected Engravings: Select an engraving to see the engraving information and display the
engraving in the preview.

Check the box next to an engraving to add it to the order. The Engravings list details the following
information:

o Name: The assigned name of the engraving.
o Type: The device type for the engraving.
o Qty: The number of engraved devices being ordered for the engravings.

Change the quantity in Selected Engraving Parts.
o Availability: The status of the product's availability. If the engraving can be ordered, the
Availability states Available. If the engraving can't be ordered, the Availability states
Discontinued, Obsolete, or Limited Supply.

o Part Type: The type of engraving order. Engraving Only or Device + Engraving (HZ2, SSW,
and SSC only).

NOTE: For Horizon® 2 keypads:
n You can choose to order the Device + Engraving or Engraving Only if you already

have the device.
n Additional charges may apply for Engraving Only. Consult with Customer

Support for concerns.

l Fit to Viewing Area: By default Fit to Viewing Area is selected. Clear it to preview the full image
which may extend out of the viewing area.

NOTE: The image is a preview only and does not represent the physical engraving.

l Engraving preview: Preview the engravings on the device.
l Actions:Create Order, Create and Email Order, and Close. Create Order and Create and Email
Order are only selectable after all of the required fields are complete. All required fields have an
asterisk (*) next to them.

o Create Order: Compiles the information obtained in the Create Engravings Order tabs to
generate an order.

o Create and Email Order: Compiles the information obtained in the Create Engravings
Order tabs to generate an order and launches an email application to attach the order
information.

o Close: Exit the Create Engravings Orderwindow. Data entered in the tabs will be saved if
the window is closed without creating an order.

https://www.crestron.com/Support
https://www.crestron.com/Support
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l Selected Engraving Parts: Details the parts information for the engravings selected in the
Engravings list.

o Model Full Name: States the model name including the color variation.
o Layout Quantity: By default, 1 is entered. If more than one engraved device is needed,
double click in the field to edit the number. This is a required field.

o Parts Ordered: Details the part names and numbers that make up the engraving.

NOTE: For some devices, one part makes up an engraving. For other devices, multiple
parts make up an engraving.

For instance, the HR-310 has only one part (HR-310-BTN-ENGRAVED) and that part
has a configuration with 10 engravable fields. The HZ-KPEX has multiple parts that can
be configured in different ways. In the example, three parts (two
HZ-BTN-RKR1-W-T-ENG buttons and one HZ-BTN-RKR3-W-T-ENG) make up one
engraving order.

HZ-KPEX Sample Engraving
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HR-310 Sample Engraving

Shipping
Provide the following shipping and billing information. By default, Use Dealer Billing Address is selected
in the Shipping Address section. If the addresses are different, uncheck Use Dealer Billing Address.
Fields with an asterisk (*) are required information.

NOTES:

l Any information provided during the Impress installation will be automatically entered here.
l Some fields may change depending on the Country selected.



88 • Impress Software Product Manual — Doc. 9377B

Required fields: 

1. Billable Dealer Information:

a. First Name

b. Last Name

c. Address 1

d. Country City

e. State

f. Zip/Postal Code

2. Shipping Address

Select Use Dealer Billing Address or enter the required information:

a. First Name

b. Last Name

c. Address 1

d. Country City

e. State

f. Zip/Postal Code



Product Manual — Doc. 9377B Impress Software • 89

Shipping Label
Each engraved device is packaged separately and an additional label is added to help identify the
purpose or location for each device. Two fields are offered for each engraving: Room and Description.
Double click in the field to enter the information.

NOTE: The Project Name entered in the Order Summary tab also prints on the shipping label.

Order Summary
The final tab provides an overview of the order.

l Dealer PO Number: Enter the Dealer Purchase Order Number. This is a required field.
l Project Name: Enter the project name. This is a required field.
l Comments: Enter any additional comments for the order.
l Select Primary Crestron Sales Office: By default, Crestron US & Canada is selected. If another
office is necessary, select one of the other location options: Crestron US & New Zealand, Crestron
Singapore, Crestron Latin America, Crestron Israel, Crestron EMEA.

l Parts Ordered: Itemized list of individual parts in the order.
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Create Order
When all the required fields are entered, Create Order is selectable.

1. Select Create Order to save the order. The Export Engraving Filewindow displays to save the
order in the Engravings project folder.

NOTE: If an engraving contains an image, the following warning displays before the Export
Engraving Filewindow. Select Continue to the Export Engraving Filewindow or Cancel to
close the warning.

2. If another name is necessary, overwrite the text in the File name. By default, The File name is the
Dealer Purchase Order Number.

The order file type is .ct_engravings_x.
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3. Select Save to save the file or Cancel to close without creating the order.

If emailing the engravings file to Crestron, refer to the following contacts:

l Crestron US & Canada: engraving@crestron.com
l Crestron Australia & New Zealand: ANZorders@crestron.com
l Crestron Singapore: AsiaOrders@crestron.com
l Crestron Latin America: ordenes@crestronlatin.com
l Crestron Israel: orders@imaginesb.co.il
l Crestron EMEA: ceurorders@crestron.com

Export Engravings File

mailto:engraving@crestron.com?subject=Engravings Order
mailto:ANZorders@crestron.com?subject=Engravings Order
mailto:AsiaOrders@crestron.com?subject=Engravings Order
mailto:ordenes@crestronlatin.com?subject=Engravings Order
mailto:orders@imaginesb.co.il?subject=Engravings Order
mailto:ceurorders@crestron.com?subject=Engravings Order
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Create and Email Order
When all the required fields are entered, Create and Email Order is selectable.

1. Select Create and Email Order to save the order and then include the file in an email. The Export
Engraving Filewindow displays to save the order in the Engravings project folder.

NOTE: If an engraving contains an image, the following warning displays before the Export
Engraving Filewindow. Select Continue to the Export Engraving Filewindow or Cancel to
close the warning.

2. If another name is necessary, overwrite the text in the File name. By default, the File name is the
Dealer Purchase Order Number.

The order file type is .ct_engravings_x.

3. Select Save to save the file and open the email client or Cancel to close without creating the
order.
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4. In the email client, review the notes in the body of the email and enter any other necessary
information. By default, the recipient email address is already populated and the order is included
as an attachment.

For more information, refer to Troubleshooting on page 98.
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Impress Best Practices
The following sections describe best practices for using Impress software.

NOTE: For best practices when engraving images, refer to Engraving Images on page 49.

Set Default Program
Impress software is backwards compatible with Crestron Studio software engraving files. To open a
Crestron Studio engraving file with Impress software:

1. Install Impress software.

2. In the file explorer, locate the engravings file.

3. Right click on the engravings file.

4. Hover over Open with and select Choose another app.
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5. Choose Impress, check the box Always use this app to open .ct_engravings_x files, and select OK.

Project Name
Follow these requirements for naming a project:

l Do not use the characters <>~|/\?* :"
l Do not start or end the name with a space.
l Do not end the name with a period.
l The full project path cannot exceed 248 characters.

Character Limit
When the engravable area character limit is met, Impress displays the following notification and
additional characters cannot be entered.

International Characters
Impress software supports engraving most international characters. To engrave Crestron products with
international characters, set the desired language as the keyboard input language on your computer.
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Save Often
Save often, especially after importing large images, copy/pasting engravings, or adding multiple
engravings to a project.

Quantity of Engravings
There is no limit to the number of engravings in an engraving project; however, keeping a single project
to fewer than 500 engravings is recommended.

If you import more than 500 engravings and receive the High Memory Usagewarning, follow these
steps:

1. Save the project.

2. Close the project.

3. Reopen the project.

High Memory UsageWarning

Import Engravings
There is no limit to the number of engravings that can be imported into a project; however, importing no
more than 100 engravings at a time is recommended. If you import more than 100 engravings and
receive the High Memory Usagewarning, follow these steps:

1. Save the project.

2. Close the project.

3. Reopen the project.
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High Memory UsageWarning

Print Preview
When printing or using the Print Preview functionality, limit the number of selected engravings to less
than 100. Printing or previewing a large amount of engravings can take a long time to generate and
may consume too much memory.

Multiple Designers
Multiple Engraving designers can be open at a time; however, if Impress performance is slow, close any
unnecessary designers.
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Troubleshooting
The following section provides troubleshooting information.

l Issue: The Create Order and Create and Email Order buttons are disabled on page 98
l Issue: The Create and Email Order button fails to launch the email application on page 99
l Issue: Cannot send attached engravings order file via email on page 100

Issue: The Create Order and Create and Email Order buttons are disabled

Ensure the required information is entered for each tab in the Create Engravings Orderswindow.

Required information:

l Engravings
o Select at least one engraving.
o Enter the quantity for each selected engraving.

l Shipping
o Billable Dealer Information:

1. First Name

2. Last Name

3. Address 1

4. Country City

5. State

6. Zip/Postal Code
o Shipping Address

Select Use Dealer Billing Address or enter the required information:

1. First Name

2. Last Name

3. Address 1

4. Country City

5. State

6. Zip/Postal Code
l Order Summary

1. Dealer PO Number

2. Project Name

3. Select Your Primary Crestron Sales Office
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Issue: The Create and Email Order button fails to launch the email application

Solution 1

1. Close the email application.

2. In Impress, click and try Create and Email Order again. Refer to Create and Email Order on page
92.

Solution 2

Use the Create Order button to save the engraving order to a local folder and manually set up the email.

1. Click the Create Order button and follow the steps in Create Order on page 90.

2. Launch the email application and attach the saved .ct_engravings_x file.

3. Enter the email address specific to your region:
l Crestron US & Canada: engraving@crestron.com
l Crestron Australia & New Zealand: ANZorders@crestron.com
l Crestron Singapore: AsiaOrders@crestron.com
l Crestron Latin America: ordenes@crestronlatin.com
l Crestron Israel: orders@imaginesb.co.il
l Crestron EMEA: ceurorders@crestron.com

4. Fill out the subject and body of the email, and then send the email.

Solution 3

On some PCs, running the email application as administrator may resolve the issue. To set the email
application to always run as admin:

1. Right click on the email application’s icon in the taskbar or the email application’s shortcut on the
desktop.

2. Click on Properties.

3. Click on the Shortcuts tab, and then click on Advanced.

4. In the Advanced Propertieswindow, check Run as administrator, and click OK.

mailto:engraving@crestron.com?subject=Engravings Order
mailto:ANZorders@crestron.com?subject=Engravings Order
mailto:AsiaOrders@crestron.com?subject=Engravings Order
mailto:ordenes@crestronlatin.com?subject=Engravings Order
mailto:orders@imaginesb.co.il?subject=Engravings Order
mailto:ceurorders@crestron.com?subject=Engravings Order
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5. Click Apply.

Issue: Cannot send attached engravings order file via email

If the engravings order file is too large to send or if you cannot attach the engravings order to the email
message for any other reason, follow the steps below to upload the engravings order file to Crestron’s
File Sharing server.

1. Go to https://uploader.crestron.com to access Crestron’s File Sharing server and log in with the
Username and Password.

To obtain credentials:
l Review the Notes section of the generated engraving email
l Contact Crestron True Blue Support

2. Click Choose file to find the desired engravings order file.

3. Click the checkbox next to the statement, I Agree to the terms of service.

4. Click Upload my File!.

5. After the file has been securely uploaded to server, a unique URL is provided under the statement,
Your download link is.

6. Launch the email application and enter the email address specific to your region.

7. Copy the unique URL provided by the Crestron’s File Sharing site in step 5, and paste it in the body
of the email.

8. Fill out the subject field and send the email to Crestron.

https://uploader.crestron.com/
https://www.crestron.com/Support
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Resources
The following resources are provided for the Impress Software.

NOTE: You may need to provide your Crestron.com web account credentials when prompted to
access some of the following resources.

Product Page
Impress Custom Engraving Software

Impress Support
Call 888.273.7876 and choose options 1, 2 or 3.

l Option 1: For questions about the Impress Software.

Email: Support@crestron.com
l Option 2: For questions about Sales Orders.

Email: customersupport@crestron.com
l Option 3: For questions about design.

Email: Techsales@crestron.com

Crestron Support and Training
l Crestron True Blue Support
l Crestron Resource Library
l Crestron Online Help (OLH)
l Crestron Training Institute (CTI) Portal

Programmer and Developer Resources
l help.crestron.com: Provides help files for Crestron programming tools such as SIMPL, SIMPL#,
and Crestron Toolbox™ software

l developer.crestron.com: Provides developer documentation for Crestron APIs, SDKs, and other
development tools

https://www.crestron.com/model/3002192
mailto:Support@crestron.com
mailto:customersupport@crestron.com
mailto:Techsales@crestron.com
https://www.crestron.com/Support
https://www.crestron.com/Support/Resource-Library
https://community.crestron.com/
https://trainingapps.crestron.com/
https://help.crestron.com/
https://developer.crestron.com/
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